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• Logging In
• Viewing the Existing Catalog Online
• Updating the Supplier Catalog Via 

Import/Export
• Updating the Supplier Catalog Online
• Responding to Incoming Purchase 

Order Requests

Overview
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Login 

Use this link to Log In:

http://ihrco.birchstreetsystems.com
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Enter Login ID (Provided by 
Interstate Hotels & Resorts)
Enter Login ID (Provided by 
Interstate Hotels & Resorts)

Enter Password (Provided by 
Interstate Hotels & Resorts)
Enter Password (Provided by 
Interstate Hotels & Resorts)

Click on “Sign In”Click on “Sign In”
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To access your 
contact 

Information  
Click on the My 

Settings link
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Enter newly personalized 
password created in the 

previous step  

Confirm/Change Name, 
Phone Number and other 

Contact Information

Enter Email address(es). (If more 
than one, separate with a semi-

colon: “ ; ”)

Click Save
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Login In Completed
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Enter Login IDEnter Login ID

Enter Personalized 
Password

Enter Personalized 
Password

Click  “Sign In”Click  “Sign In”
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Login In Completed
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Viewing the Supplier Catalog Online 
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On the “Search All Catalogs” Frame

Click on this Drop Down Box

Select “Suppliers”
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Wait until the Supplier Name appears 
in Grey and then Click “GO”
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Click on “View Products”
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Use the Scroll Bars to Navigate on the Screen
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• Exporting the Catalog into Excel
• Saving the Workbook as a new .csv file
• Formatting the Workbook for easier changes
• Making Changes to the Catalog

– Updating existing Records
– Deleting Unchanged Records
– Inserting New Records

• Importing the changes back into the v7 
Procurement System

Login In Complete

Update the Supplier Catalog Via Export/Import
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Exporting the Catalog into Excel
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Click on the “Home” Link
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Click on the “Export” Button
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Select the “Supplier Products” 
Template. Do NOT use the Price 

Update Filter.

Click on the Drop Down Box to 
Select the appropriate Filter for 

Exporting the catalog
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Click on “GO”
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Click on “Open”
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Excel Automatically opens and the Catalog is 
Displayed in a Spread Sheet Format
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Saving the file in a .csv format
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Click on the “File” Menu 
and drag down to the 
“Save As” Selection
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Do NOT Change the file type. 
The file type MUST be “CSV 

(comma delimited)”

The File Name assigned by the 
system will be highlighted.  Simply 
type an appropriate file name (i.e.: 
Your Company Name IHR Import)
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Click on the Down Arrow in the 
“Save In” Drop Down Box and a 

Folder Structure appears. The Save-
In default folder (“U7AMNKSC” in 
this example) is NOT where you 

would typically save your working 
documents.
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Using the Pointer, Select the 
Folder (or series of Folders) 
that takes you to where you 

would normally save your work. 
In this example, click once on 
the “Erogo Employee” Folder
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The Erogo Employee Folder now 
occupies the “Save in” Drop Down 

Box. Since I wish to save my 
catalog file in the “My Documents” 

folder, I must double-click this 
folder to open it and place it in the 

“Save-In” Drop Down Box
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Once the folder you wish to save in 
occupies the “Save in:” Drop Down 

Box, click on the “Save” Button
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You likely will receive the 
following warning.  Click the 

“Yes” button to proceed with the 
save in the CSV format
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You will be able to confirm that the 
save completed successfully by 

confirming that the new file name you 
selected now shows in the Title Bar of 

the new Workbook
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Formatting the Workbook to Make Changes



© 2002 Birch Street Systems

The Workbook is now ready for changes but 
in it’s current form changes will be difficult to 

make as not all the information is visible.

Columns with Number Signs 
(“####”) filling the visible 

space indicate that the column 
is not wide enough to display 
the value in the cell properly

Columns with Alphanumeric 
Characters that exceed the 

width of the cell are truncated 
(cut off) making the 

information difficult to ascertain
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To adjust all the columns 
automatically to a width sufficient 
enough for easy viewing of all the 
data, first select all the data on 
the workbook by clicking on the 
Grey Box above Row “ 1 ” and to 

the left of Column “ A ”
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Next, take the mouse and position it in the Column Heading on 
any of the lines that separate the columns. It doesn’t matter 
which one you choose. Once The Pointer changes from its 
standard “Arrow” to an object shaped like the following, 

Double-Click on the Column Heading
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The columns should now be adjusted to 
accommodate all data in each individual column.
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In order to make the Column and Row descriptions visible at all 
times, it is necessary to use the “Freeze Panes” functionality
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Select the cell immediately to the right of the last 
column which you wish to remain visible at all times 
AND immediately below the last row that you wish 

visible at all times.
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Select the “Freeze Panes” Option.  If it is not 
immediately visible on your list, wait a few seconds 

and it will appear.

Click on the Window Menu



© 2002 Birch Street Systems

After the “Freeze Frame” Option 
has been selected a solid vertical 
and horizontal line will be present 

on the screen
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Using the Horizontal and Vertical  Scroll bars to 
Navigate across and down the workbook, will move 
the columns and rows “behind” the Freeze Panes.
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• Updating existing Records
• Deleting Unchanged Records
• Inserting New Records

Making Changes to the Catalog
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The Top 3 Rows are System Defined 
and must not be altered in ANY WAY

ALL Columns are critical to the import.  Do 
NOT Delete OR Reorder ANY Columns.
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Columns that Must Contain Data
Export Filter = “Supplier Products”
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• Column A:  ACTION: Existing Records will default to “U” 
(Update)  New Records Must have “I” (Insert)

• Column B:  SUPPLIER ITEM NUMBER:  Must be entered with a 
leading “#”  The # sign will be stripped off when the file is 
uploaded back into the System

• Column C: ITEM DESCRIPTION Primary Description Label used 
by Buyers.  If you really want the Buyer to know something 
about an item then make sure to enter it here

• Column M: WILLING TO BREAK CASE: Enter “1” for YES and 
“0” for NO

Columns that Must Contain Data
Export Filter = “Supplier Products”
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• Column O: ITEMS PER CASE:  Make sure to enter a value 
greater than or equal to 1

• Column P: PRICE UOM:  Price Unit of Measure Codes. Use 
Codes Available from HELP Lists

• Column Q: MINIMUM ORDER QUANTITY:  Make sure to enter 
a value greater than or equal to 1

• Column R: UNIT PRICE:  Enter Numeric Values ONLY  (i.e. 
$57.779 would be entered: 57.779) Do NOT enter “Call For 
Quote”. If the price is uncertain enter “0” (Zero).  Put “Call For 
Quote”  in the Description field , Column C

• Column Y: EFFECTIVE DATE:  This is an important change 
from Purchase Pro. All Price Changes/Additions MUST Have an 
Effective Date. Enter in format MM/DD/YY

Columns that Must Contain Data
Export Filter = “Supplier Products”
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• Column Z: EXPIRATION DATE:  Also known as the “End Date”.  
This is the Date that this price will expire.  It is only an estimate 
but it is required by Interstate.  If you don’t have a specific end 
date for the price enter the estimated date that you will next 
update your catalog.  Buyers will still be able to place orders for 
products after this date.

• Column AG: CATEGORY ID: Buyers will only be able to view 
your Catalog items if they have an associated category. Enter 
the Category ID as identified from the Help List

Columns that Must Contain Data
Export Filter = “Supplier Products”
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• Discontinued Items
• Discontinued Items replaced by Like Items
• Updating Category IDs

Updating Existing Records
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Make sure that Column C (Item 
Description) has as much critical 

information regarding the item as possible

Make sure that Column A (Action) 
contains the letter U
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If an Item has been Discontinued. Make Sure to enter a 
Product Expiration Date.  Do NOT delete the record in the CSV 

file as this will not delete the record in the database
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If an item has been discontinued and replaced by a new item, 
DO NOT change the Item #. 
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Select the Entire Row by clicking on 
the Row Number to the Left

The proper procedure is to expire the first Item and Enter a 
New Item.  If you would like to use the discontinued Item as a 

template then follow the following procedures:
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From the Edit Menu select “Copy”
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From the Insert Menu select “Copied Cells”
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A duplicate Row has been inserted above 
the original Row. 
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Use the First Row for the item to be 
discontinued. Enter an Expiration 

Date for the Item. 
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Use the Other Row as the Template for 
the new Item to be discontinued. Enter an 

“I” in Column A (Action).
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Change Column B (Item Number) to a 
different Unique Item Number.  

Remember to prefix the number with the 
“#” sign.
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Continue making any other necessary 
change for the new item
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Price Changes
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Price Effective and End Dates
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If you need to update a Category ID for a record you must 
use the Application tools for this process. Updating the 
Category ID for EXISTING records in the Workbook will 

NOT change the Category in the system.  If you are 
Inserting a NEW record you may add 1 category ID during 

the import process. You will need to retrieve the list of 
Category IDs sorted by both ID and Description.  To 

access these lists Change applications back to the Browser 
with the v7 application
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Click “Home”
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Click “Export”
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Click “Help”



© 2002 Birch Street Systems

Click on Both Links: “Sorted by Category 
ID” and “Sorted by Category Description” 
to retrieve separate lists used to update 
Category information in the workbook
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…Select all the text in the window for 
each link and copy and paste to a Word 

or Notepad Document. Print the 
information there..
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• If the record has no changes to be made to it 
then follow the instructions on the next slides 
to delete it.

• Deleting a record in the workbook WILL NOT 
delete the item once the workbook is imported 
back into the system. Deleting items improves 
the speed of the upload process.

Deleting Unchanged Records



© 2002 Birch Street Systems

Select the Row Number of the Row with 
no changed information.
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If a number of contiguous rows have no 
changes then they can be selected for 

deletion by clicking on the first row 
number to be deleted and dragging down 

to the last row to be deleted.
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Click on the Edit Menu and select “Delete”
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The previous Record 5 is now Record 4.  
Delete all Records with no Changes prior 

to Uploading the Changed Catalog
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• Prior to Inserting New Records gather all 
information necessary to do so.

• If this information is in an Excel Workbook 
then Copying and Pasting is a good method 
for entering data in the .csv file to be 
Imported.

• Make Sure to Enter an “I” in Column A 
(Action)

Inserting New Records
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• Make Sure to enter Data in All Required Fields
• Prior to Importing make sure to Save the .csv

file
• Make sure you know in which folder the 

saved .csv file is located

Importing the changes back into the v7 
Procurement System
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If not already on this Screen, Click “Home”

Click on the Import Button
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Select the Filter Type that was originally 
Exported. “Supplier Products”

Click on the Down Arrow of the “File Type” 
Drop Down Box
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Click on the “Browse” Button to 
select the .csv file to Import
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Click on the .csv file to Select it. Then 
Click Open

If the .csv file is not immediately visible in 
the Choose file Window then use the 

“Look in:” Drop Down Box to Locate it. 
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Click on the “Submit” Button
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The Updated Catalog has been 
successfully imported.  Changes will be 
available TOMORROW.  Click “OK” to 

Continue
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• Edit Individual Items within a Catalog
• Insert New Items within a Catalog
• Assign a Catalog Item to a Catalog Category

Updating the Supplier Catalog Online
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Click OFF the “Hide Menu” Check Box
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Click “V7 Procurement” From the Main 
Menu
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The Tree Structure Opens Up. Click “Setup 
Individual Items Within a Catalog”
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The Add/Edit Item Screen Appears.  All V7 
Screens are made up of a number of Panels
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The “Logo” Panel contains important links 
and the ability to reposition and hide 

panels as necessary
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The “Navigation” or “List” Panel allows for 
searching and selecting of information to 

be processed
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The “Entry” Panel allows for 
quick data entry
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• Searching for Items
• Editing Item Information

Edit Existing Items Online
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Or Items to be edited can be selected off 
the available List.

Items to be edited can be 
retrieved via Search 

Functionality

The “Navigation” Panel is used for 
Search and List Functions.
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If desired, click on the Search Column 
Drop Down Box Down Arrow to Display a 
list of Searchable Columns. Selecting a 

Search Column reduces the time required 
to search. If “All” is selected the Search 

will look at all values in the data set.
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Type in a value to Search 
and Click “Go”
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The Search Returns all Records containin
the text string entered. Click on the 
desired Item to Load it for Editing
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“Loading” Message displays until the 
record is ready for editing
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Use the Entry 
Panel to Edit 

the record just 
loaded onto 

the form
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For example:  This particular item has 
been discontinued but is missing the 

Product Expiration Date
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Type in the Date or Click on the Calendar 
Icon….
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…and Pick a Date
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Make any other product informational 
changes required…
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Changes in price require the addition of a 
New Price and Price Effective and End 
Dates to the system. Click on the Item 

Price Tab to add a New Price. 
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To Add a New Price, Click on “Add Row”.  
Do NOT Edit existing prices.
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Enter the new price, 
price effective date 

and price end date in 
the respective fields

Click “OK” to Add the new price 
information to the Price Grid
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The New Price Information has been 
added to the Price Grid but is not yet 

Saved to the Record
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The Item Attributes tab is for additional 
detailed information to be added to the 

product document
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Information on this tab is optional
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….If you try to change to a different 
record before Clicking on “Save”….
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Click on the Cancel 
button to return to the 
record and continue 

with the Save process

…. you will get this 
Message Box 
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Click “Save” to write the 
changes to the Record to the 

Database 
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Adding New Items to the Online Catalog
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To Add New Items to the Catalog. Click on 
the “Catalog Item” Tab….
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….and Click on the New button …
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Magnifying Glasses indicate Look Up lists 
associated with that field

….and enter all the pertinent information for 
the item on this form.  These white arrows 

in blue boxes indicate Required fields.
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Look Up Lists have Search 
Functionality as well as the ability 

to simply scroll and select the Value
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The Selected item from 
the Look up List is 

inserted into the field
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After all Catalog Item and Price 
Information is added Click on Save
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The New Item is Now visible 
on the Search List

Click on the Close Button to 
Return to the Main Menu
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• For Buyers to be able to purchase your items 
the items MUST be assigned to a Catalog 
Category

Assign an Item to a Catalog Category
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“V7 Procurement” From the Main Menu
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Click on Assign a Catalog Item to a 
Catalog Category
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The Item Categorization Screen
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Enter a valid Category ID # or Lookup the 
Category from the Look Up List
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Drill Down through the 
“Tree” Structure …..
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…and select the correct Category by 
Double-Clicking on it…
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…and the Category’s Numeric ID and 
Description will be added to the record.
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If you will be assigning multiple items to 
the same Category, Click on the Set 
Defaults Button to Save the current 

Catalog and Category as the Default.  

Each time the New button is 
Clicked it will use these Defaults
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Type in the Item # to be assigned to this 
Category or select it from the Look Up List
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Click on Save
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Click on “New” to assign a 
category to a new item or to 

assign the same item to another 
category.  You may categorize an 
item into as many categories as 
you deem appropriate.  For an 
Item to be visible to Buyers it 
MUST be categorized into a 

minimum of 1 Category.  “Close” 
to return to the Main Menu
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• Accepting PO’s
• Print/View PO’s
• Rejecting PO’s
• Buyer Contact Info
• Inbox

Responding to Incoming Purchase Order 
Requests Online



© 2002 Birch Street Systems

Check the “Hide Menu” 
Checkbox to maximize 
the viewing space on 

the Screen

Click on 
“Supplier PO”
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Select the Radio Button 
next to the PO and then 

Click “View/Print PO” 
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Close to return to PO Form

Review and Print if desired 

“Notes” contain additional info pertinent to 
the PO.  “Attachment” contains other 
computer files pertinent to the PO. 

Transfer allows the PO to be transferred 
within the Supplier Organization 
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If the PO is acceptable Click on 
“Accept PO”
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Click “OK”. 
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If the PO is un-acceptable Click on 
“Reject PO”
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A Note Screen Pops Up.  Type in  
the reason for the Rejection and 

Click Save
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This Message is Displayed.  
Click “OK”. 
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For the Buyer’s Contact Information Click 
“Buyer Contact”
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To Close the Window use the “X” in the 
Windows Navigation Bar
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To Check for IHR v7 Procurement 
Messages Use the “In Box” Tab



© 2002 Birch Street Systems

The Inbox has similar Search 
capabilities or can be viewed 
in total by using the Scroll 
Bars and Clicking “View”
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Click “OK” to close the Message Window
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Click “Logout” to exit the Application
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• ALL changes Made to your catalogs will be made 
available to Buyers on the FOLLOWING Day provided 
that:
– Changes made via the Export/Import Process are imported 

prior to 3pm Pacific Time
– Changes made via the Online Application Tools are saved 

prior to Midnight Pacific Time
– Changes made after 3pm Friday and before 3 pm Sunday 

Pacific Time, will me available on Monday

Conclusion
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THANK YOU FOR ATTENDING 
SUPPLIER TRAINING


